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TEACH YOURSELF VIA VISUAL LEARNING

Visual learning is a teaching and learning style in which images, pictures or colours are used to gain
information for studying. Visual learning forms part of the three basic learning styles which includes the
Kinesthetic (learning that takes place via physical activity as opposed to listening or watching) and
Auditory (learning that takes place via listening) learning styles. Generally visual learners also have a
good sense of spatial awareness (sense of direction) and as imagery is used to visualize they also often
like to draw and scribe.

At LEARN NEW SKILLS FROM HOME, we strive to help self-study learners achieve their goals by

providing affordable learning materials without compromising on quality. All our study materials are
designed for the VISUAL LEARNER and use easy-to-follow, step-by-step instructions, illustrated

throughout via screen shots. This easy-to-use visual guide covers advanced features in popular Microsoft
Office 2007 applications and incorporates FIVE UNITS IN ONE book, Word, Excel, Access, PowerPoint and

ITQ Word. Additional learning support supplied includes examination checks, shortcut tips, test

structuDAO AT A O1 AAOPETTEIT C ETT xI AACAS , AAOT AOO xEI
Area (12 months access), which has additional question and answer snippets, job search facilities,

qualification updatesAT A A 1T AAOT A0O8 O A& 00i 8

The Advanced (level 3) units covered within this guide incorporate the globally recognised v.2.0
syllabuses for the GEuropean Computer Driving Licenced(ECDL), Gnternational Computer Driving
Licenced (ICDL) qualifications and the updated, nationally recognised syllabus for the Gnformation
Technology Qualificationo (ITQ) certification.

UNITS COVERED WITHIN THIS GUIDE

Units covered within this guide includesomA T £ OEA x1T O1 A6O 11 60 PiI bOI AC
Communication Technology) applications, which utilise the Microsoft Office suite of programs.
Applications covered:

Microsoft Word (Advanced Word-Processing)
Microsoft Excel (Advanced Spreadsheets)
Microsoft Access (Advanced Databases)

Microsoft PowerPoint (Advanced Presentations)
Microsoft Word (Advanced ITQ Word-Processing)

X X X X X

ABOUT THE AUTHOR

Paul Buggs is a certified Microsoft Office Master Instructor who has delivered ICT (Information
Communication Technology) training materials for both private and public educational providers
for over a decade.

In 2009 Paul founded LEARN NEW SKILLS FROM HOME to help self-study learner’s achieve their
educational goals using quality study guides that incorporate both maximum learning flexibility and
cost-effectiveness.
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QUALIFICATION OVERVIEW

The ECDL Foundation offers globally recognised ICT (Information Communication Technology)
certifications, which many leading corporations/governments (IBM, IKEA, Ministry of Defence, Post
Office, Bank of England, Shell and Pfizer) have adopted as their prerequisite ICT benchmark for their
employees. The quality and reputation of the Foundation has been built on over a decade of
experience in successfully delivering ICT certification to over 9 million people, in 41 languages,
covering 148 countries around the world. The ECDL (European Computer Driving Licence)
qualification was established in 1997 and due to its success the ICDL (International Computer
Driving Licence) was established shortly after in 1999 for the international market outside Europe.
Both the ECDL and ICDL certifications are global recognised qualifications and have the same
syllabus and test structures, the only difference being the ECDL is designated for European (ECDL)
countries the ICDL for regions outside Europe. Further information including qualification news
and updates can be found on the ECDL Foundation website - www.ecdl.org

ECDL (ICDL) ADVANCED MODULES

ECDL Advanced (Word-Processing, Spreadsheets, Databases and Presentations) units/modules are
set as level 3 (A-Level) qualifications in the UK by QCF (Qualifications and Credit Framework).
Advanced units/modules are designed for learners who have intermediate/advanced skills in ICT
and wish to gain a worldwide recognised certification.

ECDL (ICDL) EXPERT

Learners who successfully pass four ECDL Advanced units/i T AOT AO A ATECDA (IEE) OE A
Expertocertification at no extra cost. Further information can be found on the ECDL Expert
website - www.ecdlexpert.co.uk

© www.learn-new-skills-from-home.com _
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ITQ ADVANCED UNIT

4EA Y41 )T & Of ACET T 4 A Amproving Breductivith UsingdAFA AOED 1
introduced in 2010 to allow learners (UK only) to use their ICT skills and knowledge to manipulate
commonly used IT tools and improve their overall productivity. ITQ certifications consist of a
portfolio of qualifications which replaced the NVQ "National Vocational Qualifications" for IT and
computing units. ITQ is a UK nationally-recognised programme which has been designed by
employers to meet the needs of today's businesses. The ITQ Improving Productivity Using IT unit
can be mapped to the ECDL portfolio and once added to four ECDL Advanced (level 3) modules
enables learners to claim O E ETQ Devel 3 in IT User Skillsdcertification provided by BCS (British
Computer Society). Candidates only need to successfully achieve one of three available (Word, Excel
or PowerPoint) advanced scenario based assignments to gain the ITQ certification. 1TQ Advanced
units can be completed by both manually and automated test methods. Further information about
ITQ Units can be found on the BCS/ITQ website - www.bcsitq.co.uk

TESTING CENTRES

ECDL (ICDL) Advanced examinations incur no registration fees but examinations cost approximately

£70 per exam (prices may vary). Candidate identification is required usually in the form of a utility

bill and passport or driving licence. Learners are advised to book their desired examination date

10-14 days prior. In September 2012, manual tests for ECDL Advanced units/modules were

replaced with industry standard e-assessments. E-assessments offer many advantages over manual

tests, including instant results and abreak-AT x1 1T £ A AAT AEAAOAS8O OOOAT C

ITQ Advanced learners must register at their local testing centre (10-14 days recommended), prior
to their first examination, identification is required usually in the form of a utility bill and passport
or driving licence. A one off administration fee may be incurred of approximately £50 - £70 (prices
may vary). For further information please contact your local testing centre.

There are literary 1000's of ECDL Advanced, ICDL Advanced and ITQ Advanced test centres around

theUKAT A pnhmnnnd O @ditithd BC websae to find yBuh r@akest test centre -
http://apps.bcs.org/fac/

SAMPLE TESTS

Additional ECDL Advanced, and ITQ Advanced sample tests are available for FREE via the ECDL
website:

http://www.ecdl.org v.v
[l |

DOWNLOAD

© www.learn-new-skills-from-home.com
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BRITISH COMPUTER SOCIETY ASSOCIATE MEMBERSHIP
(AMBCS)

Learners who gain all four ECDL Advanced certifications can apply for British Computer Society
Associate Membership (AMBCS)d 8ssociate Membership is aimed at those who are at the start of
their career in IT and taking their first step on the ladder to full Professional membership. Once
approved, learners can use the letters AMBCS after their name on CV / resumes and business cards,
enhancing their job/career prospects. For further information please visit - www.bcs.org

HOW TO USE THIS GUIDE

This guide covers Advanced (level 3) features using popular Microsoft Office 2007 applications. As
this guide is set at level 3 (A-Level) it is aimed at learners who have some prior knowledge of the
application/s they wish to study. Learners can use this guide to complete individual or several
(Word-Processing, Spreadsheets, Databases or PowerPoint) units/modules. Learners who wish to
complete all five units/modules can study them in any order enabling them to concentrate on areas
of most importance first.

SOFTWARE REQUIREMENTS

ECDL and ITQ Units are non vendor-specific, which means examinations can be taken using a variety

I £ O £OxAOA j,10600 .1 OAOh -EAOT O1 £#0 | £AEXEAAR | B/
OOAET ET ¢ COEAA x Michoshfddffic©2007/84i@A The @ifiech2007 suite of

applications is predominately used within most companies globally and therefore enables learners

to maximize their prospects in finding employment and enhancing their careers. To complete the
unit/modules within this guide learners will need access to a PC (preferably with Vista, Windows 7

or Windows 8 operating system) and Microsoft Office 2007.

Free 30 day trials of Microsoft Office 2007 can be downloaded via the Microsoft website at:

http://office.mi ft.
ttp://office.microsoft.com ‘,

DOWNLOAD

UPDATES

To reflect any syllabus, exam and guide updates we have supplied an updates page, where learners
can access and download any recent changes:

http://www.learn -new-skills -from -home.com/our -courses/resources/updates.htmli ‘,
(SecondSite) https://sites.google.com/site/learnnewskillsfromhome/updates e

© www.learn-new-skills-from-home.com



MARKING SCHEMES

Once learners have completed their chosen application (Word, Excel, Access or PowerPoint)
unit/module test, they will need to printout the relevant marking scheme which is located in the
Marking Schemed Al (locAtdddn the downloaded files). Learners can cross-reference their
answers with the previously studied material within the guide. The Marking Schemes are designed
so learners can write in comments regarding their answers. Some questions can be awarded half-
marks (except multiple-choice) if partially completed but it is best practice for learners to only mark
completely correct answers as right, this is due to differing marking decisions and testing methods
(manual and automated) used.

DOWNLOADING REQUIRED WORK-FILES

All required work-filesfor OEEO OOAET ET ¢ COE A A Advandeddd OABIDIItHERGA x4
learners chosen application (Word, Excel, Access and PowerPoint) and are available for 24/7
download at:

http://www.learn -new-skills -from -home.com/our -courses/resources/work -files.html ‘
(SecondSite) https://sites.google.com/site/learnnewskillsfromhome/home —

DOWNLOAD

MEMBERSOAREA

Additional learning support supplied within this guide includes examination checks, shortcut tips, test
structuOAO AT A O1 AAROPETTEIT C ETT xI AACAS , MembdrsBApead x E |
which has additional question and answer snippets, job search facilities, qualification updates and a

I AAOT A O dodingEEtadare8upplied at the back of this guide.

KEY SYMBOLS

J— Exam Checks Test Structure

E Shortcut Tips Underpinning Knowledge

© www.learn-new-skills-from-home.com
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ADVANCED WORD-PROCESSING UNIT

The Advanced Word-Processing Unit covers advanced features, shortcuts,

examination checks and underpinning knowledge related to Microsoft Office Word
' W: 2007 certifications. The Advanced Word-Processing unit is designed to enable

learners to complete complex tasks in a Word-Processor (Microsoft Word)

application. Advanced tasks include, using sophisticated typographical, formatting

and layout configurations, including tables, forms and graphics, master documents
and using macros and advanced mail-merge operations.

WORD 2007 LAYOUT

Microsoft Office Word 2007 O OB BT O ®OCX® EjA8 O, /HieOOCK Orchat tookdver from

OEA OOMDOCAAEA ODAO OOAA EI DOAOGEI 00 WigdsatfOKicej2@D7r 1 11|
is backwards compatible enabling earlier Word versions to be opened in Word 2007 but documents

that were originally created in Word 2007 cannot be opened in older applications unless a

compatibility program is used (compatibility programs are available from Microsoft downloads

website). Besides the new XML format Microsoft Office 2007 has many more added features and
cosmetic changes compared to Office 2003 including general functionality and toolbars.

OFFICE BUTTON

-

] RIBBON TABS -

— Home Insert Page Layout References Mailings Review View De\reloperl//
= ] ibri - Y R | [y = T | =3 | Y .
B il H LN e HESRE Shdlad (k21| AaBbCcDt || AaBbCecDe AaBbCi AaBbCc GROUPS ace
Paste - 2 -|[2? - -l|l== = == - {E . i i i ~
. 7 B I U abe x, X° Aav|| é EE =E .= <) Bty TNarmal | T Mo Spadi.. Headingl Heading2 ™S Syies~ || 1 Select -
Clipboard ™= Font (F] Paragraph ) Styles (F] Editing
|-2-|-1-|-§-|-1-|-2-|-E-|-4-|-E-|-£-|-'--|-E-|-=-|-1-|-11-|-12-|-1E-|-14-|-1E-|-o-|-1?-|-1¢~- EE'
-
. PRINT LAYOUT VIEW

S N

The Word editor view is generally set as Print Layout as
default. Print Layout is ideal for user to get the best
perspective of how their document will be displayed when
completed. Page views can vary, depending on whichever
view the user last edited (Full Screen Reading, Web Layout,
Outline and Draft) and save the document in.

(

© www.learn-new-skills-from-home.com



THE MICROSOFT OFFICE BUTTON

In the upper-left corner of the Word 2007 x ET AT x (@fire Emitdho B

OEA 1/

clicked a drop-down menu will be displayed. The menu options include New, Open, Save, Save As,

Print and the Exit Word and Word Options buttons (for accessing additional commands).

OFFICE BUTTON

j Recent Documents

1 Advanced Word-Processing

Open

MENU OPTIONS

H Save As
HII’-_;:II‘J Print

ﬂ’ Prepare
_ag Send b

i Publish »

W )

-

w

B
| Close EXIT WORD BUTTON

WORD OPTIONS BUTTON +] Word Options

dialog box.

> Exit Word

Select the Alt + T + O keys to
activate the Word Options

© www.learn-new-skills-from-home.com
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RIBBON

Microsoft Word 2007 0T 1 EEA D OAOET O @ibhoAd OEI @ OO0 AORD @i ToE 000
Ribbon is located near the top of the windowh A A1 TQuickQ\Ecdss Tdolbard &t the top of the
Ribbon are several tabs; clicking a tab will display several related command groups. Within each

group are linked command buttons. Additionally a dialog box launcher is located in the bottom-

right corner of several groups, clicking the dialog box launcher option will give access to extra
commands. Itis advised that learners use the recommended (by Microsoft) 1024x768 or higher

screen resolution when using Microsoft Office 2007; this is due to a dynamic ribbon being used

which adjusts the amount of options displayed depending on visible space.

‘ QUICK ACCESS TOOLBAR

M-
COMMAND BUTTONS/OPTIONS
[RIBBON TABS Hame Insert Page Layout Referen /
3 ' Times New Foman 112 - || A A |4
" = " ab " "
P'ajte ¥ Format Painter B 7 U -~abex, X Aav||% é
Clipboard EE)IALOG BOX LAUNCHER P
QUICK ACCESS TOOLBAR
4 E Quick Access Toolbard6 EO 11 AAOAA AU AAEAOBI O AO OEA OI b

access to tools that are used frequently. The Quick Access Toolbar can be customized by adding and
removing commands to it.

Customize Quick Access Toolbar

Before starting any test questions

learners should make sure the e
Minimize the Ribboné | DOE > Open
deselected on the quick access V| save
toolbar otherwise the Office Ribbon E-mail
will be minimized every time you UINIMIZE RIBBON OPTION
click on the document page. Select

the Ctrl +F1 keys to activate the

i B kinimize the Ribbon
Ribbon option.
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SYLLABUS AREAS COVERED

Due to the new ECDL (ICDL) Advanced syllabus version 2.0 overhaul, the four Advanced ECDL and
ICDL modules (Word-Processing, Spreadsheets, Databases and Presentations) have been updated,
making the questions more relevant for modern day usage. The marking structure for the new ECDL
(ICDL) Advanced syllabus v2.0 is still the same as in the previous v1.0 syllabus with 20 questions a
required pass mark of 15 out of 20 (75%) and 1 hour time limit. The full v2.0 syllabus can be
downloaded via the ECDL website Z www.ecdl.org

UNDERPINNING KNOWLEDGE
MAIL-MERGE

BOOKMARKS

IMAGE MANIPULATION
TEXT FORMATTING

MACROS

PARAGRAPH SPACING
CHARACTER STYLES
WATERMARKS

FOOTNOTES

DOCUMENT SECURITY
FILESIZE FIELDS
DROP-DOWN LIST FIELDS
CHECK BOX FIELDS

TABLE PROPERTIES
CAPTIONS

MASTER DOCUMENTS
INDENT AND SPACING

LINK AND EMBED EXTERNAL DATA VIA MICROSOFT EXCEL
TRACK CHANGES

PAGE SETUP

DELETE SECTION BREAKS
MARK INDEX

TABLE OF CONTENTS
MODIFY TEMPLATE
DELETE/ADD AUTOMATIC TEXT ENTRIES

[T——

It is advisable learners who wish to take
just the Advanced Word-Processing
examination also work through the
Advanced ITQ Word-Processing Unit

for additional practice.

X X X X X X X X X X X X X X X X X X X X X X X X X X

[ —
0——
[]——
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ADVANCED WORD-PROCESSING 2007 GUIDE

The following guide covers advanced features, shortcuts, examination checks and underpinning
knowledge related to Microsoft Office Word 2007 certifications. Once you have worked your way
through the guide and are satisfied that you understand the information provided attempt the
Advanced Word-Processing tests located at the end of this unit.

UNDERPINNING KNOWLEDGE

Although predominately Word examinations dol &h&ve multiple-choice questions it is advisable to
study the following underpinning knowledge, as it will help reinforce application knowledge.

[ T

WORD-PROCESSOR

A word-processor is an electronic device or computer software application that can create (by
the user), edit, format and print written material.

MICROSOFT WORD

Word is a graphical word-processing program that users can add styles to text, add captions
to images and text, cross references (headings and figures), add comments to text and images,
track changes, embed objects and auto-generate tables and indexes. Word is used primarily
for creating documents such as letters, brochures, learning activities, tests and quizzes.

HISTORY

Word was first released in 1981 using a feature called WYSIWYG (What You See Is What You
Get), which meant that users could change the visual style of writing (e.g. bold, italics), by
clicking on buttons, when in other programs like WordPerfect, users had to add special
‘codes’ to change the style of writing. WYSIWYG is now a common feature of all computer
writing programs.

FILE FORMATS

Word 2007 onwards OO D B OBDCXOE A 86 ,  ABlorddaralBagdnvert documents
to different file formats including PDF (Portable Document Format) which preserves
document formatting and enables file sharing. When the PDF format file is viewed online or
printed, it retains the format that you intended. The PDF format is also useful for documents
that will be reproduced by using commercial printing methods.

™
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[ T

WORD EXTENSIONS
XML FILE TYPE EXTENSION
Document .docx
Macro-enabled document .docm
Template .dotx
Macro-enabled template .dotm
WORD TEMPLATES

A template is a document type that creates a copy of itself when the user opens it.. In
Microsoft Office Word users can create a template saving a document as a .dotx file, .dot file,
or a.dotm file (a .dotm file type allows you to enable macros in the file).

CROSS-VERSION COMPATIBILITY

As with all application types if Word is opened in a version (2000, 2003, 2007, 2010, 2013

A O A &H@rithan the edition it was created in, can cause an incorrect display of the document.
The document formats of the various versions can change in subtle and not so subtle ways
(including fonts, footnotes A O A 8

Word formatting created in newer versions does not always survive when viewed in older
versions of the program, nearly always because that capability does not exist in the previous
version. Rich Text Format (RTF), an early effort to create a format for interchanging
formatted text between applications, is an optional format for Word that retains most
formatting and all content of the original document.

IMAGE TYPES

Users can insert many popular graphics file formats into their document either directly or
with the use of separate graphics filters. Compatible file types include:

Enhanced Metafile (.emf), Graphics Interchange Format (.gif), Joint Photographic Experts
Group (.jpg), Portable Network Graphics (.png), Microsoft Windows Bitmap (.bmp, .rle, .dib),
Windows Metafile Graphics (.wmf) and Tagged Image File Format (. TIFF).
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SHORTCUTS
KEY GENERAL
ALT+TAB Switch to the next window.

ALT+SHIFT+TAB

Switch to the previous window.

CTRL+W or CTRL+F4 Close the active window.

ALT+F5 Restore the size of the active window after you maximize
it.

SHIFT+F6 Move to a task pane from another pane in the program
window (counterclockwise direction).

CTRL+F6 When more than one window is open, switch to the next

window.

CTRL+SHIFT+F6

Switch to the previous window.

CTRL+F10

Maximize or restore a selected window.

ALT+PRINT SCREEN

Copy a picture of the selected window to the Clipboard.

CTRL+SHIFT+SPACEBAR

Create a nonbreaking space.

CTRL+SHIFT+HYPHEN

Create a nonbreaking hyphen.

CTRL+B Make letters bold.

CTRL+I Make letters italic.

CTRL+U Make letters underline.

CTRL+SPACEBAR Remove paragraph or character formatting.
CTRL+C Copy the selected text or object.

CTRL+V Paste text or an object.

CTRL+ALT+V Paste special

CTRL+SHIFT+V

Paste formatting only

CTRL+Z

Undo the last action.

CTRL+Y

Redo the last action.
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KEY PRINT AND PREVIEW DOCUMENTS

CTRL+P Print a document.

ALT+CTRL+I Switch to print preview.

Arrow keys Move around the preview page when zoomed in.
PAGE UP or PAGE DOWN Move by one preview page when zoomed out.
CTRL+HOME Move to the first preview page when zoomed out.
CTRL+END Move to the last preview page when zoomed out.
KEY REVIEW DOCUMENTS

ALT+CTRL+M Insert a comment.

CTRL+SHIFT+E

Turn change tracking on or off.

ALT+SHIFT+C

Close the Reviewing Pane if it is open.

KEY

OUTLINE VIEW

ALT+SHIFT+LEFT ARROW

Promote a paragraph.

ALT+SHIFT+RIGHT ARROW

Demote a paragraph.

CTRL+SHIFT+N

Demote to body text.

ALT+SHIFT+UP ARROW

Move selected paragraphs up.

ALT+SHIFT+DOWN ARROW

Move selected paragraphs down.

ALT+SHIFT+A

Expand or collapse all text or headings.

ALT+SHIFT+L

Show the first line off body text or all body text.

ALT+SHIFT+1

Show all headings with the Heading 1 style.

ALT+SHIFT+n

Show all headings up to Heading n.

CTRL+TAB

Insert a tab character.
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DOCUMENT SECURITY

Select and open the Survey document located within the Advanced Word-Processing folder
by double clicking it.

Double clicking
documents will open

SURVEY DOCUMENT them automatically in
= Word.
] Survey

I"-.Iamej Date modified Type

The Survey document will automatically open in Word.

SURVEY DOCUMENT

PROPOSAL FOR NEW -
CAR PARK

ST

If the Document opens in another application
(1T 000 .1 OAOh Yterdybumassmt A
have Word set as your default Word-Processor
(right click the document and select the Open
With, Microsoft Office Word options.) software.
Alternatively Microsoft Office Word may not be
installed on your machine. Free 30-60 day trials
are available for download at:

http://office.microsoft.com

L4

DOWNLOAD
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Select the Save As option from the Office Button.

) e

i |
¥ Open

=]

W Convert

Select the F12 function
. key to activate the Save
H Save

As function.
SAVE AS OPTION} H save s i

The Save As box will be displayed. Select the Tools, General Options located at the bottom
right corner of the Save As box.

TOOLS OPTIONj
Tools -

Map Metwork Drive...

Save Options...

GENERAL OPTIOID General Options...

A

The General Options box will be displayed. Enter the password Gcdl-icdld j x EQOET 60
into the Password to open: box (it will be displayed in security format). Select the OK
button.

[ e |
F GENERAL OPTIONS BOX "
General OptiDnsL l I._l_J@ —

General Options |

File encryption options for this document | I

Password to OPEN: | sessessss| PASSWORD TO OPEN BOX ’

SECURITY FORMAT ’
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The Confirm Password box will be displayed. Retype the password (ecdl-icdl) in the
Reenter password to open: box. Select the OK button.

CONFIRM PASSWORD BOX
Confirm Password
[

REENTER PASSWORD TO OPEN: BOX

Reenter password to open:

Caution: If you lose or forget the passWOT, T CArmOT DS
recovered, (Remember that passwords are case sensitive,)

| Ok | | Cancel

Save the Survey document in its original location (Advanced Word-Processing folder) with
its original name (Survey), by selecting the Save button.

cene T g
Save as type! | word Document X |Z| Cancel

It is advisable to close then
reopen the Survey document
to test the recently added

password.

[ —
0——
N—

TRACK CHANGES

Open the self-study document located in the Advanced Word-Processing folder by double
clicking it.

Double clicking
documents will open
them automatically in

Word.

SELF-STUDY DOCUMENT 01,/08/2012 12:0
01082012 124

] self-study.docx 01,/08/2012 15
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Select the Review tab located on the ribbon.

. {REVIEW TAB]
Review

Select the Track Changes button within the Tracking group.

Changes option, select the
= Show Markup - Ctrl + Shift + E keys.
Track Balloons
Changes = - E Reviewing Pane ~
‘ TRACKING GROUPj Tracking

N\

The Track Changes option allows users to track changes made to a
document, including deletions, formatting and insertions.

To activate the Track
TRACK CHANGES BUTTO] } ] * Final Showing Markup - .

Right click the misspelled O A mfﬁ)ryé x EOEET OB dubniehvndlibddisgdeged with
spelling suggestionsh O A1 Aufofs C) E Brd®thd submenu.

Self-study like distance learning allows

The spelling correction will be displayed with the original text.

‘ ORIGINAL AND CHANGED TEXT [fsignificant savings in study costs for learners. Many
why use self-study as they don’thave any supportvia

| =H:1-'EEH"—'F'L'1.1‘|:DI'S this is not specifically true a majority of self-study courses are
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3AT AAO 1&aEnhgtO AX@FO EET OE Bighlightngit. AT O AU

to complete their learning HIGHLIGHTED TEXT

date. Additionally the inte%j ! — *&reeded in abundance learners need

7EOE OEA OAQO OOEI IstuliesG & | amBkd&iAeit will beRlidplayedE A OA O«
alongside the original text.

date. Additionally the internet has i e learners need
to complete their learningstudies. ORIGINAL AND CHANGED TEXT

Select the Office Button, Save options.

FOFFICE BUTTONM
Select the Ctrl + S

j New keys to activate the
Save option.

7 Open

| I — {SAVE OPTIONj

Select the Office Button, Close options.

fomcnz BUTTONM

Select the Alt + Spacebar then
j New select the C key to activate the
Close option.
= S
¥ Open

J Close
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DELETE SECTION BREAKS

Open the Independent Study document located in the Advanced Word-Processing folder
by double clicking it.

INDEPENDENT STUDY DOCUMENT E.f'[l?_r’EUIE 17:18 Microsoft Office ...

= = f07/201217:19
4] Independent Study.docx  05/08/2012 13:22
hilj Master.docx 29/07/201217:19

Double clicking
documents will open
them automatically in

Word.

Select the Home tab (if required) located on the ribbon.

Home 4 HOME TAB

Select the Show/Hide option within the Paragraph group.

Select the Ctrl + * keys to
‘ SHOW/HIDE OPTIOID‘!T | activate the Show/Hide
=== - option.

PARAGRAPH GROUP} Faragraph

I
The Show/Hide option displays the documents Paragraph Marks and other hidden formatting

symbols. Unless deactivated the paragraph marks will be displayed when the document is
saved or subsequent documents are opened within the current Word session.

™

The section break on the first page will be displayed.

Independent'Stu dYﬂ Section Break (Mext Page) ... {SECTION BREAK ’
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Select just prior to the displayed Section Break and select the Delete key located on the
keyboard.

A Next Page Section Break starts a
new section on the next page of the
document, whereas a Continuous

SELECTION POINT Section Break starts a new section on
the same page. -

Independent'studYﬂ section Break (Mext Page)

The Section Break will be deleted and text previous on page 2 of the document will be
displayed on the first page of the file.

Independent-Study

TEXT FROM PAGE 2
irhe-general-perception-of undertaking-further-education-is todnitially

university,-private-and-distance training-provider,all-ofwhich-can-be very-expensive-andtime-

consurmning.-Howevertheredis-analternative wayto-learn-and-gain-knowledge-and-recognition-

insteadtraditiom™ : A — — E— ent-
o Paragraph Marks will not be displayed when a document is

study-is-andncr ) ) . . e . Brners:
_ printed. Once a question criteria is complete it is advisable

maximum-le nd-

to turn off paragraph marks by selecting the Show/Hide

term-times. option previous shown (this is due to Paragraph Marks
1 obscuring subsequent document alignments, which may cost
candidates precious editing time).
g
]—
]—

Select the Save option located on the Quick Access Toolbar.

Select the Ctrl + S keys
to activate the Save

[SAVE OPTIONﬂ
option.

gLl - -

‘ QUICK ACCESS TOOLBAR
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PAGE SETUP

Open the Independent Study document (if required) located in the Advanced Word-
Processing folder by double clicking it. Select the Page Layout tab located on the ribbon.

E’AGE LAYOUT TAB
Fage Layout

Select the Orientation drop-down option located within the Page Setup group.

ORIENTATION DROP-DOWN OPTION ’

By Ij = Breaks ~
=) 39 Line Numbers -
Margins (Orientation| Size Columns

: - ) "/ PAGE SETUP GROUP

Page Setup

Select the Landscape option from the drop-down menu.

The new page orientation will Sy

affect the documents layout (line (=]

endings, E1 A C A Othidi§pArg ( |Orentation
of the built-in format and no

amendments are required, unless x j Partrait

stated within the question
criteria.

LANDSCAPE OPTION

==j Landscape

[ g—
J—
)—

The page orientation has now changed to Landscape.

Independent Study | LANDSCAPE ORIENTATION ’ ‘ AMENDED LINE ENDINGS ’

The general perception of undertaking further education is to initially enrol with a college, university, private and distance training provider, all of which

can be very expensive and time consuming. However thereis an alternative way to learn and gain knowledge and recognition instead traditional learing
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Select the Office Button, Save options.

OFFICE BUTTONM
Select the Ctrl + S

j New keys to activate the
Save option.

7 Open

| I — {SAVE OPTION]

Select the Office Button, Close options.

FOFFICE BUTTONDM

j = Select the Alt + Spacebar then
. select the C key to activate the
/7 DOpen Close option.

[cmsns OPTION} - @
4 Close

WATERMARKS

Open the Plans document located in the Advanced Word-Processing folder by double
clicking it.

Double clicking

Date modified Type i
PLANS DOCUMENT YP documents W_III open
05/01/2010 15:36 Microsoft O them automatically in

4] Plans 05,/01/2010 15:37 Microsoft Word.

@ Survey 05/01/2010 15:37 Microsoft O
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The Plans document will automatically open in Word.

PLANS DOCUMENT

NEW CAR PARK IN BRIDGE STREET

Select the Page Layout tab located on the ribbon.

— E’AGE LAYOUT TAB
Page Layout

Select the Watermark drop-down option within the Page Background group.

Al @ ]

atermark Page  Page

o
WATERMARK DROP-DOWN OPTI@ K Color = Border
Page Background ﬁ PAGE BACKGROUND GROUP

A drop-down menu will be displayed, select the Custom Watermark option.

A Custom Watermark... @STOM WATERMARK OPTION

_—]

Watermarks are generally set as semi-

transparent allowing inserted objects (text and

graphics) printed over a Watermark to be
clearly visible.

(
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The Printed Watermark box will be displayed. Select the Text watermark radio button.
Select the SAMPLE option from the Text: drop-down list. Ensure the Semitransparent
check box is selected (usually set as default), select the Apply and Close buttons.

‘ PRINTED WATERMARK BOX ’

F \/
Printed Watermark |i|£_hj

Mo watermark

Picture watermark

TEXT WATERMARK RADIO BUTTON ’ Once the Apply button has

been activated the Cancel

W]
%]
(=]

~ i button will be replaced
@) Text watermark with the Close button.
Language: |English (Upitedinadac Alternatively candidates
Text: eample | SAMPLE OPTION ’ can select the OK button
- S which will automatically
_ add the Watermark and
Size: Auto [~ close the Printed
. Color: |E| | Semitransparent Watermark box.

Layout; i i -
SEMITRANSPARENT CHECK BOX |_
Cancel | |

The SAMPLE watermark will be displayed in semi-transparent form within the document.

NEW CAR PARK IN BRIDGE STREET

We have done comprehensive research to gauge whether there is demandfor
a new public car park in Bridge Street and we are very confident that our
proposal for a new public car park will be a resounding success. We have
appropriate financial backing in place and our bank has assured us that they
will support the building plan.

EAMPLE WATERMARK

Watermarks will appear
on each existing and newly
created pages within the

document.
=
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Select the Office Button, Save options.

e

tOFFICE BUTTON &

e

Select the Ctrl + S keys
to activate the Save
option.

Open

— {SAVE OPTION]

e Lo
=
2

L

FULL VERSION (620 PAGES)

PAPERBACK - £19.99

(Available via Amazon)

EBOOK PDF - £9.99

(Available via LULU)
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eBook PDF - £9.99 eBook PDF - £9.99
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]
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Take the first step towards a better future...
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